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  شرح یک پروژه

 ایـن    بـا  یی ابتـدایی   آشـنا  گفتـیم    MSP مقدماتیکه در قسمت    توضیحاتی  تمامی  

  . حال شرح مختصري از یک پروژه به شما می دهیم ،نرم افزار بود

 یـا سـاختار   WBS  بایـد  بـا  آن آشـنا شـوید     MSPیکی از اصـطلاحاتی کـه در      

. است Work Breakdown structureدر اصطلاح یا شکست کار

 اولین قدم جهت شروع برنامه ریزي یک پـروژه شـناخت نـسبت بـه محـدوده ي                 

اطلاعـات کلـی    پروژه مد نظر است این شناخت می تواند یک شناخت کلی باشـد              

پـروژه    نام پیمانکار، نام مدیر پروژه، هدف انجام پروژه، نام کار فرما ، نام مشاور،         

،تـاریخ پـیش بینـی پایـان، مبلـغ      ، تاریخ شروع پروژه ،مدت زمـان انجـام پـروژه     

مـی توانـد در قالـب یـک         ... کـار و    قراردادي پروژه، موقعیت جغرافیایی ، احجام       

فرم شرح مختصر پروژه به منظور داشـتن         . ح مختصر پروژه بیابید   شرفرم به نام    

 پـروژه و بـه عنـوان شناسـنامه پـروژه در             یک چهار چـوب کلـی جهـت شـناخت         

  .اصطلاح تعیین می شود

 در wordیـا  Excel یـک فایـل   فرم شرح مختصر پروژه را می توانید در قالب 

اطلاعات فرم شرح مختصر پروژه را می توان از مطالعه قـرارداد ، بررسـی               . آورد  

نقشه هاي موجود براي پروژه ، صحبت با مدیران ، بازدید منطقه اجراي پـروژه و               

  .امثال این تهیه کرد
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WBSیا در اصطلاح ساختار شکست کار چیست؟   

سـت پـس   ه اژ یکی از مهمترین فازهاي برنامه ریزي و کنترل پرو  WSBتعریف  

، از شناخت کلی نسب به اهداف و احجام کلی پروژه باید پـروژه را بـه واحـد هـا                     

 همان فعالیت اجرایـی پـروژه       WBS. ر تقسیم کنیم  تفعالیت ها و اقدامات کوچک    

    WBSاست که در قالب گروه هاي مختلفی دسـته بنـدي مـی شـود بـا تعریـف       

 شده راحـت تـر بـه نظـر          کنترل پروژه در قالب مجموعه فعالیت هاي دسته بندي        

  . می رسد

دسته بندي فعالیت ها این امکان را به ما می دهد تـا در ارتبـاط بـین فعالیـت هـا                      

همچنین نظرات و نیازمندي هاي منـابع مـورد نیـاز جهـت اجـرا ایـن هـا را بهتـر                      

  . تشخیص بدهیم و نسبت به تعریف آن ها اقدام کنیم 

ت سلی ـ. اي پـروژه اسـت      شـناخت فعالیـت ه ـ     WBSاولین قـدم جهـت تعریـف        

فعالیت هاي پروژه باید به گونه اي باشد که قابل مدیریت ،برنامه ریزي و کنترل               

باشد  به عبارت دیگر باید فعالیت هاي پروژه به اندازه اي خرد و کوچـک شـوند               

اد مربـوط بـه   ي پروژه را می توان با مطالعه اسـن     فعالیت ها . که قابل کنترل باشند     

 با افراد   WBSد اجرایی تهیه کنیم البته بهتر است که براي تهیه           قراردادها و اسنا  

مدیر اجرایی و امثال این افراد      ،   رئیس دفتر فنی    ، مسئول در پروژه رئیس کارگاه    

مشاوره با افرادي که در پـروژه هـایی ماننـد پـروژه شـما حـضور                 . مشورت کنیم   

  .داشتند می تواند بسیار مفید باشد 

اي اجرایی پروژه را تهیه کردیم نوبت به دسته بنـدي آن            پس از آن که فعالیت ه     

ناحیـه   ،ها معمـولا بـر اسـاس نـوع فعالیـت هـا            این دسته بندي فعالیت     . می رسد   

جغرافیایی و گروه هاي انجام دهنده فعالیت انجام می شـود بهتـر ایـن اسـت کـه                   

WBSدرختی طراحی کنیم را ابتدا به صورت یک نمودار .  
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  .  وارد نرم افزار می کنیم راار و رفع نواقص، آن نمودپس از تکمیل 

همانطور که در شکل می بینید ما پروژه احداث یک ساختمان را داریم که در زیر                

اسـیون و عملیـات خـاکی قـرار       ب اسکلت ، اجـراي فوند     آن ساخت و نص   مجموعه  

  .دارد

 دارد که   دب اسکلت و ساخت اسکلت وجو     در قسمت ساخت و نصب اسکلت ، نص       

  .کدام داراي زیر مجموعه هایی هستند هر 

است که ما در اینجا مثالش را بـراي شـما گفتـیم       WBS این یک نمودار درختی

،Visio مثـل  اسـتفاده از نـرم افزارهـایی    که شما مـی توانیـد ایـن نمـودار را بـا      

Diagram Designer و یا با نرم افزارهاي نسب نمودار تهیه کنید .  
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  Gantt Chart پر کردن جدول 

 ، طریقـه ایجـاد یـک پـروژه جدیـد را توضـیح       طور که در قسمت مقـدماتی    همان

  .یک پروژه جدید ایجاد می کنیمدادیم 

  

  

 نام فعالیت ها خود را یادداشت  Task nameحال می توانید بیایید در قسمت 

 ـ ...  مانند عملیات خاکی ، نقشه برداري، اجراي بتن و قالب بندي و              :کنید ه که نمون

:کامل شده آن را در شکل زیر می بینید
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شما باید نام فعالیت ها را کوتاه انتخاب کنید به گونـه اي کـه نـشان دهنـده نـوع                     

 کردن  به جاي تایـپ       Copyاجرایی باشد می توانید از قابلیت       عملیات و فعالیت    

Taskدر قسمتکنید به عنوان مثال ما می توانیم  با دبل کلیک کردن استفاده 

informationدر قسمت بعد  ب اسکلت را کپی کرده ونص Pastکنید .  

 

  

یا روي آن کلیک راست انجام دهید و گزینه کپی را بزنید و در مکان مـورد نظـر                    

Past کنید .  

توانید هنگام ورود فعالیت     شما می . حال دسته بندي فعالیت ها را انجام می دهیم          

هـاي اجرایـی را وارد نماییـد و سـپس      تنها فعالیـت  Task nameها در ستون 

براي دسته بندي فعالیت ها نام فعالیـت هـاي سـرگروه را در لابـه لاي سـطرهاي             

MSP                  و در جایی که مایلید انجام دهید براي اضافه کردن یـک سـطر از فعالیـت 

  .ها در بین سطرهاي فعالیت ها مانند زیر عمل می کنیم

و روي گزینـه ي     اسـت مـی کنـیم       وس کلیـک ر   اروي سطر مورد نظر به وسیله م ـ      

New task  کلیک می کنیم .  
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 مایل باشید نام فعالیت را از لیست هاي فعالیـت خودمـان مـی تـوانیم حـذف                   اگر

روي سطر مورد نظر کلیک راست انجام داده و گزینـه ي          ؛ به این صورت که      کنیم

Delete Task  را می زنیم .  
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ا باید یک فعالیت را به عنوان سر گـروه یـا    براي ایجاد دسته بندي فعالیت ها ابتد      

فعالیت مادر در نظر بگیریم سپس فعالیت زیر مجموعه اي آن را مشخص کـرده               

به عنوان مثال همان گونه که در نمـودار  . و زیر مجموعه فعالیت مادر قرار بدهیم        

WBS  که شما مـی توانیـد نـوع    .  شما دیدید پروژه احداث اسکله ساختمان است

Fontایـن کـار را مـی توانیـد از نـوار ابـزار       .تا مشخص شـود  را تغییر دهید  آن

Formatting استفاده کنید .  

  

  

  

 وس عملیـات هـاي زیـر مجموعـه        اه شما پروژه مادر را تعریف کردید با م        کحال  

  .کنید  اي آن را انتخاب میه

  

  . روي نوار ابزار کلیک می کنید  Indentو روي گزینه 
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 را روي نوار ابزار مشاهده نکردید می توانید از طریق منـوي   Indentاگر دکمه 

Projectگزینه   رويOut line  کلیک کرده و بعد Indent را کلیک کنید .  

  

  

  

براي قسمت هاي بعدي فعالیت مادر نیز به همـین گونـه عمـل مـی کنیـد کـه بـه                      

  :صورت خلاصه 

  Task nameتهیه کردن  )1

  نام فعالیت مادر )2

  مشخص کردن زیر مجموعه ها )3

Indent  (Alt + Shift + Right)زدن گزینه  )4

  :که جدول به صورت زیر آماده می شود 
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حال اگر در بیان پروژه مادر دچار مشکل شدید و یا خواستید آن را حـذف کنیـد                  

 کـه   Out dentروي گزینـه  خـاب کنیـد و بعـد    ابتدا زیر مجموعه هـا آن را انت 

  .  است کلیک می کنیمIndentخلاف جهت 

 Out و بعد روي گزینه Out line شده روي گزینه  Projectو یا وارد منوي 

 dent را انتخاب می کنیم .  

   



12

 که پروژه هایی که ایجـاد کـرده اي را در            اگر بخواهیم پروژه اي ایجاد کنید     حال  

ــه      ــد روي گزینـ ــی توانیـ ــد مـ ــف ببینیـ ــطوح مختلـ ــوار  Showسـ  روي نـ

  . هاي مختلف را ببینید  levelو  Formattingابزار

  

  

  All Sub Task هـا را ببینیـد روي گزینـه     Taskاگر دوباره خواستید تمـام  

  .کلیک می کنید

 را انتخـاب اولـین پـروژه مـی آیـد چـون        Level(2)باید دقت کنیـد کـه وقتـی    

MSP نام پروژه را به عنوان Level(1)   انتخاب می کند.  

MSPنام پروژه به عنوان سطح صفر در نظر گرفته شود کهدر برنامه ریزي باید 

 وارد  Tools این کار را نمی کند بـراي رفـع ایـن مـشکل مـی توانیـد از منـوي        

Options  و گزینه Viewرا انتخاب کنید .
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 Show Projectهمان طور که در این پنجره می بینید شما می توانید گزینـه  

Summary Taskرا فعال کنید .  

ر این گزینه را فعال کنید از نشان هاي مثبت و منفی کنار گزینه هـا در جهـت                    اگ

 نمایش فعالیت هاي زیر گروهی می توانید بهره مند شوید یعنی اگر شما مثبت و              

منفی را بزنید همان گونه که در شکل مشاهده می کنید زیر مجموعه ها را به شما                 

  .ندمی ک) پنهان ( Hideیا آن ها را نشان می دهد 
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 Projectاگر خواستید این علامت ها نشان داده نـشوند مـی توانیـد وارد منـوي            

 را انتخـاب   Hide Out Line Symbolsبعـد    و Out lineو گزینه  شوید

. کنید 
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  :MSP  در هاانواع فعالیت

  : را می توان به سه دسته تقسیم کردMSPفعالیت هاي موجود در 

  Taskفعالیت هاي  )1

  Summary task هاي فعالیت )2

  .ستونلفعالیت هاي مای )3

 هستند فعالیت هایی که در سـطح اجـرا و           Task از نوع    MSPاکثر فعالیت هاي    

.  نامیـده مـی شـوند      Taskیا به عبارتی در پایین ترین سطح هستند فعالیت هاي           

 یا فعالیت مادر مـی  Summary Task فازهاي پروژه را به نام هاي MSPدر 

 هـستند ترکیبـی از   Summary Taskیت مـادر کـه بـه عنـوان     فعال. شناسیم 

فعالیت هایی هستند که در سطح پایین تر از آن قرار می گیرند که ما مـی تـوانیم     

یـک سـري فعالیـت هـاي زیـر          .  بـدانیم    Taskآنها را ترکیبـی از فعالیـت هـاي          

مجموعه اي یا خرد شده در مجموع یک فعالیت اصلی را تشکیل می دهـد کـه بـه         

  . گفته می شودSummary Task آن

تمامی فعالیت ها در ابتدا به صورت منفرد هستند ولی پـس از درج فعالیـت هـاي     

 Summaryدیگر در سطح پایین تر و تقسیم بندي گروهـی بـه صـورت یـک     

Taskمدت زمان .  در می آیندSummary Task  بر اساس زمـان و تقـدم و  

یعنی به عنـوان مثـال   . یین می شود زیر مجموعه آنها تعTaskفعالیت هاي   خرأت

 نقـشه   Durationاگر شما بخواهید ببینید عملیات خـاکی چنـد روز اسـت بایـد               

  .برداري ،خاك برداري و تسطیح را مشخص کنید 

فعالیت هاي مایلستون داراي زمان صفر هستند و براي نشان دادن شروع و پایان              

دن نقاط کلیـدي پـروژه کـه        پروژه ،شروع و پایان فازهاي اصلی همچنین نشان دا        

داراي اهمیت خاصی هستند استفاده می شود از نقاط کلیدي پروژه می تـوانیم بـه                

تاریخ عقد یک قرار داد مهم در طول یک پروژه ، تاریخ خریـد یـک نـوع کـالاي                    

مهم ، تاریخ اتمام یک کار مهم یا تاریخ رسیدن به درصد پیـشرفت مشخـصی در                 

  .  کردطول پروژه و امثال آن اشاره
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توجه خاص به اهداف مهم پروژه و مایلستون ها می تواند سـبب تـسریع در امـر                  

  .مدیریت پروژه بشود

 در نمـاي    :براي ایجاد یک فایل فعالیت مایلستون به این ترتیـب عمـل مـی کنـیم               

Gantt chart  و گزینـه  م کلیـک راسـت مـی کنـی    م هر جا کـه خواسـتی New 

Task و یک کرده را انتخاب  Task مید ایجاد می کنی جد.  

همـان طـور کـه    .  نام فعالیت مایلستون را می نویـسیم  Task nameدر ستون 

  دو مایلستون شـروع پـروژه و   ،براي این پروژه  . گفتیم زمان مایلستون صفر است    

ا بـه   در نمـودار سـمت راسـت مایلـستون ه ـ         پایان پروژه را وارد مـی نمـاییم  کـه            

.دصورت لوزي نمایش داده می شو
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  :ع فعالیت ها از نظر قیود زمانیانوا

قیـود  .  می توانیم هشت نوع قید زمانی براي فعالیت هـا تعریـف کنـیم                MSPدر

  .زمانی در محدود کردن فعالیت ها از نظر زمانی مناسب هستند

 ASAP (As Soon As Possible) ٍ1)

کـه وابـستگی هـا اجـازه مـی      با ایجاد این محدودیت فعالیت در زود ترین زمـانی        

 هستند و بـه     ASAPمعمولا اکثر فعالیت ها در یک پروژه        . شروع می شود   هندد

 هنگامی که فعالیت را وارد می کنیم قید زمـانی آن            MSPصورت پیش فرض در     

  . است ASAPبه صورت تعریف شده 

2) ALAP (As Late As Possible)    

بـه  فعالیـت در ایـن حالـت        . شـود    فعالیت در دیرترین تاریخ ممکـن شـروع مـی         

از این قید براي فعالیت هایی در پـروژه اسـتفاده مـی           . صورت بحرانی در می آید    

  .ندازیم  اکنیم که بخواهیم تا حد امکان به تاخیر بی

3) FNET (Finish No Earlier Than)
زمانی کـه در سـتون   . فعالیتی که زود تر از تاریخی که وارد شده پایان نمی پذیرد 

Finish    الیت، تاریخ خاصی از روي تقویم انتخاب کنیـد ایـن      براي زمان پایان فع

  .قید براي فعالیت در نظر گرفته می شود

4) SNET (Start No Earlier Than)
ایـن قیـد مـوقعی    .شـود شـروع نمـی شـود      فعالیت زودتر از تاریخی که وارد مـی     

انتخاب می شود که بخواهیم فعالیت در تاریخ خاصی شروع بـشود و یـا از تـاریخ          

نحـوه ي ایجـاد ایـن محـدودیت ماننـد ایجـاد          . نظـر زود تـر شـروع نـشود          مورد  

  . استFNETمحدودیت 

5) FNLT (Finish No Later Than)
  . پایان فعالیت دیرتر از تاریخی که ایجاد شده اتفاق نمی افتد 

6) SNLT (Start No Later Than)
ایـن قیـد زمـانی،      . شروع فعالیت دیرتر از تاریخی که وارد شده اتفاق نمـی افتـد              

  .زمانی بکار می رود که فعالیت باید تا تاریخ معینی شروع بشود

7) MFO (Most Finish On)
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  .این قید زمانی به کار می رود که یک فعالیت باید در تاریخ خاصی پایان بپذیرد

8) MSO (Most Start On)
  .وع بشود این محدودیت وقتی به کار می رود که فعالیت باید در زمان خاصی شر

  

در بکار بردن محدودیت هاي زمانی باید دقت کرد چون استفاده نامناسب باعـث              

گـاهی اوقـات ممکـن اسـت بـه          . افزایش زمان بهم ریختگی شبکه کاري می شود       

طور ناخواسته تاریخی را به عنوان شروع و یا پایان فعالیت انتخاب کنید ، در ایـن          

ید در حالی کـه شـما خواهـان چنـین       صورت براي فعالیت محدودیت ایجاد می کن      

محدودیتی نیستید پس بـه شـما پیـشنهاد مـی کنـیم در ابتـدا بـدون ایجـاد هـیچ                      

محدودیتی و تنها با توجه به زمان و روابط بین فعالیت ها بر نامـه ریـزي را انجـام       

 در صورتی که نتایج مطلوب بود ، نیـاز بـه ایجـاد قیـد زمـانی بـراي ایجـاد             ، دهید

  .اریدفعالیت ها ند

اختصاص دادن قید زمانی به فعالیت ، در چنین زمانبندي این فعالیت نسبت بـه               با  

  . پیدا می کنندارجحیتفعالیت هایی که داراي اولویت کمتري هستند 

اري را آمـوزش    ز بـه شـما طریقـه قیـد گ ـ         MSPکه ما در قسمت بعدي آموزش       

.خواهیم داد
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MSPمحاسبه زمان در 
  : می شوند به سه دسته تقسیمMSPفعالیت ها از نظر محاسبه زمان در 

1(Fix Duration ) دوره زمانی مشخص شده(  

2(Fix Work ) کار مشخص شده(  

3(Fix Unite ) واحد مشخص شده(  

 Fixالیـت وابـسته بـه زمـان یـا همـان       عبا مـشخص کـردن یـک فعالیـت بـه عنـوان یـک ف       

Duration                  در صورت درج زمان براي این فعالیت این زمان ثابت خواهد بود و بـا تغییـر 

   در حالی که فعالیت اگر وابسته به منبع یا همان.بع، زمان فعالیت تغییر نخواهد کرددر منا

Fix Work یا Fix Unite  باشد در صورت تغییر منبع زمان فعالیت هم تغییر پیدا می 

 پـروژه بـه شـما    Fix Durationبا توجه به ثابت بودن زمان پروژه ها یا به عبـارتی  . کند

در پـروژه هـاي   . انجـام بدهیـد   Fix Durationژه را به صورت پیشنهاد می شود که پرو

عمرانی و به خصوص پروژه هایی که در ایران انجام می شـود معمـولا زمـان پـروژه و زمـان                   

فازهاي اجرایی عدد ثابتی است و مدیران با توجه به چنین زمان هایی به دنبال تـامین منـابع                   

  : زمانی براي فعالیت ها چگونه باید عمل کردحال براي تعریف قید. مورد نیاز خود می روند

روي فعالیت مورد نظر دو بار سریع کلیک می کنیم و صفحه اي مثل صـفحه زیـر ظـاهر مـی         

  .شود
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  Constraint  و بعـد روي گزینـه ي  .  کلیـک مـی کنـیم   Advancedما روي گزینـه  

Type نوع قید هایی را که در MSPب می کنید پیشرفته قسمت اول گفتیم را انتخا.  

  

  

  

. را می زنیمOKو بعد گزینه 

 As Soon به صورت MSPالیت ها درعیک نکته قابل توجه این است که بدانیم تمامی ف

As possible پایان آن هـا   در این صورت تاریخ شروع و. به صورت پیش فرض هستند

 را بتـوان بـه      بر اساس زمان و روابط آن ها محاسبه می شود براي اینکه فعالیت هاي پـروژه               

 تعریف کرد و از وابستگی به منابع رهـا کـرد بـه صـورت زیـر       Fix Duration صورت 

  .عمل می کنیم

 بـاز   Task Informationروي فعالیت مورد نظر دوبار کلیک می کنیم و وقتی پنجره 

 گزینـه  Task Type می شویم و بعد در قسمت Advancedشد دوباره وارد گزینه ي 

Fix Duration   را انتخاب می کنیم.  
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    را کـه در کنـار همـان گزینـه      Effort Driven  و بعد از آن گزینـه  

  . را می زنیمOKاست را غیر فعال می کنیم و بعد از 

 Fix Unite یـا    وFix Workاسـت و از حالـت    Fix Duration حال فعالیـت شـما   

  .خارج است

 قرار گیرد می توانید تمـام آن   Fix Durationبراي اینکه تمام فعالیت هاي ما به حالت 

 Task گزینـه  Project کـردن انتخـاب کنیـد و از منـوي      Drag & Dropهـا را بـا   

Information را بزنید و تمام آنها را در حالت Fix Duration قرار دهید .  
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       ايفعالیت هاي دوره 

ژه به طور مرتب و در فواصل       فعالیت هایی که در طول یک دوره و یا در قسمتی از زمان پرو             

  .زمانی یکسان اتفاق می افتند ،مثل تشکیل جلسه هفتگی در روزهاي خاصی از هفته 

 را انتخاب مـی کنـیم بعـد، از منـوي     Gantt Chartبراي این کار یک سطر خالی از نماي 

Insert گزینه Recurring Taskرا انتخاب می کنیم .  

  

  

نام فعالیتی که می خواهیم انجـام دهـیم را وارد مـی     Task Nameدر قسمت نام یا همان 

 مـدت زمـان    Durationکنیم به عنوان مثـال تـشکیل جلـسات هفتگـی و بعـد در قـسمت                

قسمت بعدي روزهایی که مـی خـواهیم را انتخـاب مـی      فعالیت را انتخاب می کنیم و بعد در       

  .و تاریخ شروع و پایان را هم مشخص می کنیم. کنیم
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 روز مـی  53ا بزنید سوالی از شما پرسیده می شود مبنی بر ایـن کـه جلـسات        ر okکه وقتی   

  .را انتخاب می کنید YESشما گزینه  شود آیا تمایل دارید و
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  . اضافه شده استGantt Chartحال می بینید تمام جلسات هفتگی به جدول 
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  ایجاد یک یادداشت براي یک فعالیت

داشت براي یک فعالیت است که وقتـی شـما روي آن      تعریف یک یاد   MSPیکی از مزایاي    

  .قرار بگیرید آن یادداشت ظاهر می شود

 Notesبراي این کار روي فعالیت مورد نظر دو بار کلیک می کنید و بعد از آن روي گزینه

یادداشت مورد نظر خود را تایپ می کنیم بـه عنـوان مثـال مـا بـراي قـسمت             کلیک کرده و  

 را مـی  okو بعـد  اي استفاده شـود  باید از نقشه برداران حرفه   : کنیمنقشه برداري تایپ می     

.زنیم

  

  

کنار فعالیت یک آیکون جدید به وجود آمـد کـه اگـر مـا روي ایـن                مشاهده می کنید که در    

  . وجود داشت ظاهر می شودTaskآیکون قرار بگیریم نکته مهمی که در رابطه با این 
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   بین فعالیت هاRelationshipنحوه ارتباطات یا 

که این .  چهار نوع ارتباط می توان بین فعالیت هاي پروژه برقرار کرد MSPبه طور کلی در

  :ارتباط ها به این صورت است

    FS(Finish to Start)ارتباط  )1

  .این ارتباط به این گونه است که شروع فعالیت به پایان فعالیت دیگر وابسته است

   SS(start to start)ارتباط  )2

  .نیاز وابسته است شروع فعالیت به شروع فعالیت پیش

  FF(Finish to Finish) ارتباط )3

  .نیاز وابسته است پایان فعالیت به پایان فعالیت پیش

SF(Start to Finish)ارتباط )4

شـروع  ) 2(به عنوان مثال نگهبـان شـیفت  . نیاز پایان فعالیت بعدي است  شروع فعالیت پیش  

  .وابسته است) 1(یان فعالیت نگهبان شیفت فعالیتش به پا

  : می توان به طرق مختلف ارتباط بین فعالیت ها را برقرار کردMSPدر 

  

  :روش اول

 بود می توانید به عنوان سـریع تـرین راه ایـن          FSاگر نوع ارتباط شما بین فعالیت ها از نوع          

  :کار را انجام دهید 

  :فعالیت مورد نظر را انتخاب کنید

  

  

  . را انتخاب می کنیم Link Task گزینه Editنوي از م
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در صورتی که بخواهیم ارتباط ایجاد شده را از بین ببریم دوبـاره فعالیـت انتخـاب کـرده از                    

  . را انتخاب می کنیمOut Link گزینه Editمنوي 

  

  : روش دوم

 روي فعــالیتی کــه مــی خــواهیم انتخــاب کنــیم دوبــار کلیــک مــی کنــیم و بعــد روي گزینــه 

Predecessorsنیاز یا همان  شماره پیش  رفته وIDفعالیت را تایپ می کنیم .  

نیاز خاك برداري نقشه برداري است که در صورت نیـاز مـی توانیـد در                 به عنوان مثال پیش   

  . میزان تاخیر فعالیت را وارد نمایید Lagقسمت 

  

  

  .ا مشخص کنید رFS و SF،SS،FF شما میتوانید نوع ارتباط که  Typeو در قسمت 
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  :روش سوم

  . را انتخاب می کنیم split گزینه ي Windowمنوي  از

  

در صـفحه پـایینی کلیـک    . همانگونه که مشاهده می کنید پنجره اي براي شما بـاز مـی شـود             

  :راست می کنیم که پنجره اي باز می شود مانند شکل زیر 

  

  

  

و سپس فعالیتی را که . کلیک می کنیمPredecessors & successorsروي گزینه 

و .  انتخاب می کنیم  Gantt Chartمی خواهیم براي آن وابستگی تعریف کنیم در نماي 

  . نوع ارتباط را تعریف می کنیمTypeدر قسمت پایین در قسمت 
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  .نیاز که در قسمت قبل هم توضیح دادیم را وارد می کنیم  شماره پیشIDو در قسمت

  . را می زنیمOKانجام دادیم دکمه بعد از این که این کار را 

  

  

  

  . را می زنیمHideگزینه ي   شده وwindowو براي از بین بردن پنجره ایجاد شده وارد 
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  تخمین زمان فعالیت ها

 تعریف زمـان    MSPیکی از مراحل مهم در برنامه ریزي و کنترل پروژه به کمک نرم افزار               

 در ستون Gantt Chartه راحتی در منوي زمان فعالیت ها را می توان ب.فعالیت ها است 

Duration                     وارد کنیم اما نکته مهم رسیدن به یـک تخمـین مناسـب از زمـان فعالیـت هـا 

تخمین زمان فعالیت هاي پروژه با توجه به نوع پروژه و نوع نگرشی که بـه مـدیریت                  . است

  .اجرایی پروژه خواهیم داشت متفاوت است

سان در دو پروژه متفـاوت زمـان هـاي متفـاوتی را وارد         ممکن است شما براي دو فعالیت یک      

  .کنید چون شرایط اجرایی در دو پروژه متفاوت است

  :براي این که بتوان مدت زمان فعالیت را تخمین زد از روش هاي زیر استفاده می کنیم

.اطلاعات قدیمی قبلی ، مانند پروژه هایی که قبلا انجام شده.1

.فعالیت را انجام دهنداز طریق افرادي که قرار است .2

.نظر کارشناسانی که قبلا پروژه اي شبیه پروژه شما را مدیریت کرده اند.3

.سازمان صنعتی یا حرفه اي که پروژه هاي شبیه پروژه شما در ارتباط هستند.4

ن مدت زمان فعالیت ، ممکن است از ترکیـب روش هـاي             یدر پروژه هاي پیچیده براي تخم     

زیرا تخمین هایی که دقیق نیستند ، ریسک انجام پروژه          . ده کنید یا روش دیگر استفا    فوق و 

شما براي وارد نمودن زمان پیش بینی شده می توانید بـه صـورت زیـر عمـل     . را بالا می برند   

  :کنید

  : می شویدProject Information وارد گزینه Projectاول از منوي 

  

  



15

  :بعد پنجره زیر باز می شود

  

  

  

 Finish date روز شـروع فعالیـت و در قـسمت    Start dateقسمت شما میتوانید در 

در قسمت هاي بعدي بر نامه اي که مـی خواهیـد بـراي               تاریخ پایان فعالیت را وارد نمایید و      

 و Start را بزنید در قسمت   Okو وقتی   .زمان بندي پروژه خود داشته باشید را انجام دهید        

Duration جدول Gant Chartان ها وارد می شوند به صورت زیر زم:  
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 نمودارها به صورت زیر  یعنی جدول نمودارها ،Gantt Chartو در قسمت راست جدول 

  .ددر می آ ی

  

  

  

 می بینید نشانه تخمینـی   Durationعلامت سوالی که در کنار روزهاي موجود در قسمت 

  .بودن زمان مورد نظر است

 وارد گزینـه  Project انیـد از منـوي   اگر این علامت سوال براي شما مشخص نبود مـی تو 

Filter شوید و آن را فعال کنید .  
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Gantt Chartاضافه و یا کم کردن ستون در 

اضافه یا کم کنیم.بـراي ایـن    Gantt Chartما می توانیم یک ستون در فضاي 

را  Hide Columnکــار روي آن ســتون کلیــک راســت انجــام داده و گزینــه 

  انتخاب می کنیم.

  

ــک راســت کــرده و     و ــراي اضــافه کــردن ســتون روي یکــی از ســتون هــا کلی ب

را انتخاب می کنیم که پنجـره اي ماننـد پنجـره     گزینه

  زیر براي شما باز می شود.

  

  

  

 OKتیتري که مورد نظرمان است  را وارد می کنیم و در آخـر   Titleدر قسمت 

را می زنیم.
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CPM (روش مسیر بحرانی)  

رسـیدن  یک پروژه و ایجاد ارتباطات و زمان فعالیـت  WBSهدف ما از تعریف 

  است.به یک شبکه زمان بندي

شبکه زمان بندي پروژه شامل فعالیت ها، ارتباطات و زمان فعالیت هـا اسـت کـه    

در برنامه ریزي زمان پروژه به ما کمک می کند. شبکه زمان بندي به ما می گوید 

د نسبت بـه هـم باشـند و قبـل از شـروع      چه فعالیت هایی با چه تقدم و تأخري بای

فعالیت چه فعالیت هایی باید انجام شوند. در شبکه زمان بندي، زمان فعالیـت هـا   

مشخص شده است و زمان انجام کل پـروژه را مـی تـوان بـه کمـک شـبکه زمـان        

  بندي پیش بینی کرد.

وژه مسیري که طولانی ترین زمان را تعیین می کند و به اصطلاح مسیر بحرانی پر

  است در شبکه زمان بندي مشخص می شود.
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  مشخصات مسیر بحرانی  

مسیر بحرانی مانند هر مسیر دیگري در پـروژه  از اولـین فعالیـت شـبکه شـروع      

شود و تا آخرین فعالیت بدون هیچ گسستی ادامه پیدا می کند مسـیر بحرانـی   می

  طولانی ترین مسیر و بزرگترین مسیر شبکه زمان بندي ها است.

الیت هایی که در مسیر بحرانی قرار دارد همگی بحرانی هسـتند و بـه عبـارتی    فع

شناوري آن ها صفر است. هر پروژه حداقل یک مسیر بحرانی دارد ممکن اسـت  

در طول پروژه به علت عقب افتادن و اضافه شدن زمان فعالیت ها مسیر بحرانـی  

-ن پروژه هم زیـاد مـی  تغییر پیدا کند، پس با اضافه شدن زمان مسیر بحرانی زما

شود و در صورت کاهش زمان فعالیت هاي مسیر بحرانی زمان پروژه هم کاهش 

  پیدا می کند.

جهت انجام به موقع پروژه بهتر است تمرکز ما بیشـتر روي فعالیـت هـاي مسـیر     

بحرانی باشد البته نباید از سایر فعالیت ها هم غافل بشویم چـون تـأخیر زیـاد در    

  م ممکن است آن ها را بحرانی کند.سایر فعالیت ها ه
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MSPمشخص کردن زمان بحرانی به کمک 

 Ganttرا به دو صـورت   MSPمی توانیم پیگیري مسیر زمان بندي پروژه در 

Chart  وNetwork Diagram    مشاهده کنیم که در منـويView   شـما

  هر دوي آن ها  را دارید.

  

  Gantt Chartمسیر زمان بحرانی در 

زمان فعالیـت هـا بـه صـورت میلـه هـاي مسـتطیلی شـکل          Gantt Chartدر

  هستند.

  

  

و ارتباط بین آن ها به صورت بردار مشخص می شود. براي مشخص کردن مسیر 

  کار هاي زیر را انجام می دهیم. Gantt Chartبحرانی در نماي 

را انتخاب مـی کنـیم.   گزینه  Formatاز منوي 

ظــاهر شــد گزینــه   Gantt Chart Wizardبعــد از ایــن کــه صــفحه ي

Standard  راNext    کــرده و در قســمت بعــديCustom Gantt 

Chart   راNext  کنیممی.  

  

http://www.iepu.ir


7

  

  

سپس مشخص می کنیم در  چه قسمتی این اطلاعات را براي ما وارد کنـد کـه در   

  آخر به صورت زیر مشخص می شود.

  

  

  

  Network Diagramمسیر بحرانی در 

    ا انتخاب می کنیم.ر Network Diagramابتدا 

  

  

گـره مسـتطیلی شـکل     "هر فعالیت با یک  Network Diagramدر نماي 

  ، نشان داده شده است."
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و ارتباطات بین فعالیت ها با بردار خطی مشخص شده است به عبارت دیگر ایـن  

  نماد همان شبکه گره اي زمان بندي است.

لاعات فعالیت از قبیل : تـاریخ  در گره هاي مستطیل شکل مربوط به فعالیت ها اط

شروع، تاریخ پایان زمان، درصد پیشروي و غیره دیده می شـود و ایـن اطلاعـات    

تا به براي این کار می توانید دو بار روي آن ها کلیک کنیدقابل ویرایش هستند.

  صورت زیر در آیند و بعد آنها را ویرایش کنید.

  

  

-یت ها بیشتر تمرکز کنیـد ایـن نمـا  مـی    اگر می خواهید بر روي ارتباط بین فعال

  براي شما مفید تر باشد.  Gantt Chartتواند از نماي 

-با رنگ قرمـز مشـخص مـی     Network Diagramمسیر بحرانی در نماي 

  شود.
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  را به دلخواه خود تغییر دهیم  Network Diagramچگونه 

کرده  را کلیک Box Styleمی شوید و گزینه  Formatابتدا وارد منوي 

  

  

  خود را تغییر دهید. Network Diagramدر آنجا می توانید 

  

  

  

،  از بخـــش "رنـــگ  ":  Color،  از بخـــش "شـــکل  ": Shapeاز قســـمت 

Border    و از قســمت   "شـکل، رنـگ و ضـخامت خـط دور شـکل       "مـی تـوان

Back ground  را تغییر داد، کـه   "رنگ و قالب پس زمینه شکل  "می توان

 Okقابل مشاهده هستند. با زدن دکمـه   Previewییرات در بخش همه این تغ

  این تغییرات اعمال می شوند.
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  )assignment resource definition(تعریف و تخصیص منابع

یکی از فـاز هـاي مهـم در مبحـث برنامـه ریـزي و کنتـرل پـروژه فـاز تعریـف و           

از نـرم افـزار    تخصیص منابع است. در حال حاضر در کشـور مـا  هنگـام اسـتفاده    

MSP زیاد توجـه   "منابع  "به و سایر نرم افزارهاي کنترل پروژه مثل پریماورا

نمی کنند.نکته ي حائز اهمیت زمان فعالیت هـا اسـت،  امـا معـدود شـرکت هـا و       

سازمان هایی هستند که به خوبی این امکان نرم افزار را شـناخته انـد و بـه منـابع     

  توجه بیشتري دارند.
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  یف منابعروش تعر

منابع معمولاً شامل نیروي انسانی مثل کارگر، ماشـین آلات، مصـالح، تجهیـزات و    

  مانند این ها هستند.

و یـا کـار و    Workدر این نرم افـزار دو نـوع منبـع قابـل تعریـف اسـت، یکـی        

یــا مــواد اســت. نیــروي انســانی و ماشــین آلات بــه عنــوان  Materialدیگــري 

Work  و مصالح به عنوانMaterial .بکار برده می شود  

می توان تعریف منابع را در حین تخصـیص منـابع  انجـام داد.امـا اگـر       MSPدر 

  نخواهیم این کار را بکنیم می توانیم به این روش عمل کنیم:

  

  را انتخاب می کنیم.  Resource Sheetگزینه  Viewاز منوي 

  

  

-انتخـاب مـی   ) راWorkیا  Costیا Materialنوع منبع ( Typeدر ستون 

  کنیم.

  

  

  

ــابع  Material Labelدر ســتون ــراي من ــع را   Materialب ــد منب ــام واح ن

  .یادداشت می کنیم،  مثل متر مکعب

  

  

  

http://www.iepu.ir


12

  حرف اختصاري جهت منبع را وارد می کنیم Initialsدر ستون 

  

  

اگر این کار را انجام ندهیم نرم افزار به طور خودکـار حـرف اول نـام منبـع را در     

نـام گـروه منبـع را وارد مـی کنـیم.        Groupقرار می دهد. در ستون ستون این

  این گروه بندي ها به هنگام گزارش پروژه به کار می آیند.

  حداکثر مقدار در دسترس منبع را وارد کنید.  Max unitsدر ستون 

  

  

بعضی اوقات وقتی ماوس را روي بعضی نقاط می گیریم یـک پنجـره کوچـک بـه     

باز می شود که با کلیک بـر روي آن لینـک موجـود در آن پنجـره      Helpعنوان 

  باز شده و در مورد موضوع مورد نظر اطلاعاتی به ما می دهد. Helpبزرگتر 

  

  

  نرخ استاندارد واحد منبع را وارد می کنیم. STD. Rateدر ستون 

  نرخ اضافه کاري هر واحد را وارد می کنیم. Ovt . Rateدر ستون

  نرخ هزینه بر واحد منبع را وارد می کنیم  USA/Costدر ستون 

  نحوه پرداخت هزینه را انتخاب می کنیم. Accrue Atدر ستون 

Start      ،به معنی پرداخـت هزینـه در شـروع فعالیـتEnd    در پایـان فعالیـت و

prorated     در طول فعالیت را نشان می دهـد. در سـتونBas Calendar 

باشد یا بر اسـاس تقـویمی کـه      Standardکه تقویم منبع را انتخاب می کنیم 

  .قبلاً توضیح داده شده کارها را انجام دهد
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  تنظیمات مربوط به محاسبات  

  .را انتخاب می کنیم Optionsگزینه  Toolsاز منوي 

  

  

  را باز می کنیم. Generalدر پنجره باز شده تب 

  

  

 Default Overtimeو   Default Standard Rateدر این قسمت 

rate یا تومان در ساعت نظر می گیریم.را ریال  

تعـداد رقـم اعشـار را مشـخص      Decimal digitsدر قسمت  Viewدر تب 

نوع نمایش هزینه را می توان مشـخص کـرد     Placementمی کنیم.در بخش

  تنظیمات اعمال می شود. Okکه به چه شکل باشد و با زدن 
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لیـت مـی تـوانیم بـه مـدت هـاي مختلـف        بعد از برآورد منابع مورد نیاز براي فعا

انجام دهیم. قبل از این که تخصیص منـابع را شـروع    MSPتخصیص منابع را در 

کنیم،  تمام فعالیت ها را از وابستگی به منبع رها کنیم. براي این کار تمام فعالیت 

 Task Informationوارد قسـمت   Projectهـا انتخـاب کـرده از منـوي     

 Fined Durationرا به صـورت   Advance  ،Task Typeشده در تب 

  می کنیم. Okرا غیر فعال می کنیم. سپس  Driverقرار داده و 

  

  

 Viewبهترین روش تخصیص منابع در این نرم افـزار ایـن اسـت کـه در منـوي      

ــه  ــیم و   Gantt Chartگزین ــاب کن ــاهده  Gantt Chartرا انتخ را مش

-را انتخـاب مـی   Assign Resourcesگزینـه   Toolsکنیم.سپس از منوي 

  .را می زنیم Alt+F10کنیم یا 

  

  

باز شود. فعالیتی که می خواهیم به آن منبـع   Assign Resourcesتا پنجره 

اختصاصی دهیم انتخاب کرده مقدار مورد نیاز منابع مـورد نظـر را طبـق بـرآورد     

را مـی زنـیم و    Assignوارد مـی کنـیم و کلیـد     Uniteانتخاب کرده در فیلـد  

  می کنیم. Closeآن را  سپس
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اگر بخواهیم هنگام تخصیص منابع منبع جدیدي را که در لیسـت وجـود نداشـت    

وارد کنیم،  در همان پنجره در انتهـاي لیسـت و در یـک سـطر خـالی اسـم منبـع        

در نظـر   Workبـه طـور پـیش فـرض منبـع       MSPجدید را وارد مـی کنـیم در   

منبع جدید دوبار کلیک می کنیم و در گرفته می شود که براي تغییر آن رو سطر 

  Material Labelآن،از بخـش   "نـوع   "  Typeپنجره باز شـده از بخـش   

آن مشخص می شـود و   "حرف اختصاصی  " Initialsآن و از بخش  "واحد "

پنجره را می بندیم.   Okبا 

  

  

براي تغییـر دادن درصـد بـه عـدد  و بـالعکس بـه ایـن         Max Uniteدر ستون

  می کنیم:روش عمل 
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بــراي تعــداد و  Decimalرا در حالــت  Options، دکمــه Toolsدر منــوي  

Percentage  براي درصد قرار داده وOk .را می زنیم  

را به صورت فعال در آورده، از منـوي   Gantt Chart، گزینه Viewاز منوي 

Windows  گزینهSplit    را فعال می کنیم.در زیر پنجره اي باز می شـود کـه

Resource home    و تغییر اطلاعات را در معرض دید قرار می دهـد. بـراي

  را می زنیم. Hide From Viewبستن با کلیک راست بر روي پنجره گزینه 
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  منابع به منظور رفع تداخل منابع صحیحت

تداخل منبع زمانی رخ می دهد که بـه یـک منبـع بـیش از آن کـه مـی توانـد کـار         

ت اتوماتیـک بـه ایـن صـورت انجـام      ع به صورتخصیص شده باشد. تخصیص مناب

  شود :می

بـا توجـه بـه وابسـتگی هـا زمـان        MSPاگر از تصحیح اتوماتیک استفاده کنـیم،  

شناوري،  تاریخ ها، اولویـت هـا، قیـود زمـانی یـا محـدودیت هـاي تعریـف شـده          

مشخص می کند که کدام فعالیت باید به تأخیر بیفتد. قبـل از تصـحیح اتوماتیـک    

جاي ممکن زمان بندي پروژه را مورد ارزیـابی و تحلیـل قـرار دهـیم و بـه       باید تا

وسیله تصحیح دستی تداخل منبع را رفع کنیم. هنگامی که زمان بندي پـروژه بـر   

اساس تاریخ پایان است نباید از تصحیح اتوماتیک استفاده کنـیم چـون ایـن کـار     

  ایان پروژه می شود.موجب تغییر تاریخ پایان فعالیت ها و در نتیجه تاریخ پ

ــوي   ــک از من ــراي تصــحیح اتوماتی ــه  Toolsب را  Level Resourceگزین

 Leveling Calculationانتخاب می کنیم. در پنجـره بـاز شـده در بخـش     

کلیـک مـی   Level Nowرا انتخاب کرده روي گزینـه   Automaticگزینه 

  کنیم.
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  گزارش گیري منابع

MSP ید می کنـد کـه مـا مـی تـوانیم از آن هـا       گزارش هاي مختلفی براي ما تول

جهت ارئه اطلاعات به مدیران پروژه یا در جلسات اجرایی پروژه یا در تجزیـه و  

می توان منابع مورد نیاز پـروژه را در دوره   MSPتحلیل پروژه استفاده کنیم.در 

هاي مختلف زمان گزارش گیري کنـیم. محاسـبات ایـن گـزارش هـا بـر اسـاس        

که به فعالیت ها داده ایم مثـل مـدت زمـان تـاریخ شـروع و      تخصیص هایی است 

  پایان فعالیت ها.

  

  گزارش گیري از منابع پروژه

را انتخــاب کــرده در پنجــره بــاز شــده   Reportsگزینــه  Reportاز منــوي 

را مـی زنـیم.در پنجـره      Selectرا انتخاب کرده  Work loadگزارش هاي 

را زده،  جزئیـات را   Edit،  را انتخـاب کـرده   Resource usageباز شـده  

گـزارش     را انتخاب می کنیم Selectگزینه  Okمشخص کرده و پس از زدن 

  آماده نشان داده می شود.
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اگر بخواهیم گزارشات مقدار منابع مورد نیاز پروژه خود را به تفکیک در جداول 

را انتخــاب  Resource Sheetگزینــه  Viewجداگانــه بگیــریم از منــوي 

،  بـه قسـمت   Group،  پـس از تعریـف گـروه بـراي هـر منبـع در سـتون        کرده

Report   ،رفتــهWork Load  را انتخــاب مــی کنــیم. در پنجــره بــاز شــده

Resource usage     را انتخـاب مـی کنـیم وEdit     را مـی زنـیم و در بخـش

Filter ،Group  را مشخص می کنیم وOk .را می زنیم  

که نام گروه مـورد نظـر را مـی خواهـد،  بـا       ،  پنجره اي باز شدهSelectبا زدن 

  کردن، گزارش گروه بر روي صفحه نشان داده می شود. Okزدن آن و 

  براي گزارش گیري از هزینه هاي مورد نیاز پروژه این عمل را انجام می دهیم:

را غیر فعال کرده،  بر اساس جدول مقدار  Resourceگزینه  Viewاز منوي 

  هزینه منابع را پیش بینی می کنیم. منابع مورد نیاز پروژه

وارد  Std. roteبراي این کار پس از وارد کـردن نـرخ واحـد منبـع در سـتون     

را مـی زنـیم. در    Selectرا انتخـاب کـرده    Costsشـده    Reportsپنجره 

  را می زنیم. Editرا انتخاب کرده،   Cash Slowپنجره باز شده

را  Selectکـرده،   Okخـاب کـرده،    شکل مورد نظـر را انت  Filterو از بخش 

  زنیم.گزارش نشان داده می شود.می
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  پروژهپیش بینی هزینه هاي 

معمولا در گزارش هاي کنترل پروژه از نمودارها و گراف ها استفاده می شود تـا  

مدیران راحت تر تجزیه و تحلیل کنند. یکی از مهمتـرین نمودارهـا در ایـن کـار     

مـی تـوان جهـت رسـم ایـن       MSPعات و گزارشات است. که از اطلا S7نمودار 

  نمودارها استفاده کرد.

 Excelمی توان از نـرم افـزار  پیش بینی هزینه هاي پروژه  Sبراي رسم نمودار 

را  Costsرا بــاز کــرده،   Reportsاســتفاده کــرده و بــراي ایــن کــار پنجــره 

  انتخاب می کنیم.

http://www.iepu.ir


21

  

  

  را می زنیم . Select،  را انتخاب کرده Cash slowدر پنجره باز شده 

قـرار دارد را بـه    Totalوقتی گزارش دیده شد عددي را که در سـطر از سـتون   

  را می کشیم. Sمنتقل می کنیم و نمودار Excelنرم افزار 
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افزار نگاهی بر نرم

MS Project 2007

:داورندگان گر

      نادیا بطحایی

    علیرضا محسنیسید 

  

    هاي جناب دکتر قاسمی با تشکر از راهنمایی
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  فهرست

  ٣.................................................................................................................  :شروع جهت هیاول ماتیتنظ

  ۴.........................................................................................................  :میتقو و پروژه يکار يزمانها میتنظ

  ٧...............................................................................................................  :پروژه يزمانبند و يزیر برنامه

  ٨.................................................................................................................  :Gantt Chart یسازمانده
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  ١۶  ........................................................................................................................  :پروژه يساز بهنگام
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  ١٨  .......................................................................................................................  :پروژه مهم ماتیتنظ

  ٢٠  ...................................................................................................................  :افزار نرم مهم ينما چند
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  ٢٣  .....................................................................................................................  :آنها ي هیته و گزارشها
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٣

  :تنظیمات اولیه جهت شروع

  :باید مقدمات زیر را فراهم کرد افزار،جهت شروع کار با نرم

داد اساس شرح خدمات مندرج در قراري کار پروژه معمولاً بر در این قسمت محدوده: ي آنروژه و محدودهتعریف پ

.گیردمورد توجه قرار می

جهت این کار: آن ي زمانبنديزمان شروع، زمان کنونی پروژه و نحوه  Project > Project Information  را

.کنیمانتخاب می

  

Current، )ي زمانبندينحوه(Start date ،Finish date  ،Schedule fromدر شکل بالا  date  ،Status date 

غیر از تاریخ  یتواند در کنترل حین اجراي پروژه در روزهایاین تاریخ وضعیت می. دهدرا نشان می )تاریخ وضعیت(

ماندگی آن را تا دو ماه دیگر که مدیر پروژه از آن مثلاً شاید ما بخواهیم وضعیت پروژه و عقب. مؤثر واقع شود امروز

  .کند بدانیمبازدید می

  :ي زیر را انتخاب کنیمباید یکی از دو نحوه Schedule fromفاده از جهت است

ریزي را به شکلی دنبال کنیم که زمان پایان پروژه را ژه را داشته و بخواهیم برنامهزمان شروع پرو اگر.1

.کنیماستفاده می Start date  بدانیم از

به شکلی دنبال کنیم که زمان شروع پروژه را ریزي را اگر زمان پایان پروژه را داشته و بخواهیم برنامه.2

Finish  بدانیم از date کنیماستفاده می.
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  :هاي کاري پروژه و تقویمتنظیم زمان

  : 2003تقویم 

هاي کاري و تعطیل و دنبال این هستیم زماندرواقع با تعریف تقویم به. کاري را تعریف کردهاي قبل از شروع پروژه باید تقویم

  .ات کاري پروژه را بدانیمساعچنین هم

  .کنیمطی میرا  Change Working Time  >Tools براي تنظیم تقویم پروژه مسیر

  

هاي تیره رنگ سفید روزهاي کاري و خانههاي بهاند که خانهدر شکل بالا، در قسمت میانی، روزهاي هفته نشان داده شده

Use.(ي روزهاي تعطیل هستنددهندهنشان default  (  

طیل تع )ها رامثلاً جمعه(ي خاصی را براساس استاندارد پروژه) هاي سفید رنگخانه(چنانچه بخواهیم روزهاي کاري موجود 

ها جهت انتخاب خانه.(را بزنیم Nonworking timeي هاي مورد نظر را انتخاب کنیم و سپس دکمهکنیم باید خانه یا خانه

  .)نیم یا با یک کلیک بالاي هر ستون، آن ستون مورد نظر کلاً انتخاب خواهد شداستفاده ک Ctrlتوانیم از کلید می

ها را را تبدیل به روزهاي کاري کنیم باید آن خانه یا خانه) هاي تیره رنگخانه(چنانچه بخواهیم روزهاي تعطیل موجود 

-استفاده می )روز کاري شودفرض، به معناي برخلاف پیش( Nondefault working time يانتخاب کرده و سپس از گزینه

  .کنیم

-افزار به ما این اجازه را میطور که مشخص است نرمهمان. در قسمت سمت راست ساعات کاري در هر روز قابل مشاهده است

  .استفاده شده است Fromو Toدهد که در بین ساعات روز چند استراحت را داشته باشد و به همین منظور از کلمات
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  :توانیم نوع تقویم را مشخص کنیم که یکی از سه نوع زیر استمنوي مورد نظر می در بالاي

) ساعت در یک شیفت 8طور معمول روزي به(تقویم استاندارد .1

تقویم شیفت شب.2

 )هاي تولیدي پیوستهمانند سیستم(ساعته  24تقویم .3

  :دگردرا فشار دهیم منوي زیر باز می Optionsي منو، اگر دکمهدر پایین 

  

  

ي کار در هر هاي شروع و خاتمه، زمانترتیب روز شروع کاري در هر هفته، ماه مالی پروژه در شروع هر سالدر شکل بالا به

  .اندروز، و تعداد ساعات کاري در هر روز، تعداد ساعات کاري در هر هفته و تعداد روزهاي کاري در هر ماه مشخص شده
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۶

:2007تقویم 

  .کنیم تقویم پروژه مسیر زیر را طی میبراي تنظیم 

Tools > Change Working Time  

در پایین پنجره . متفاوت است MSP 2003کمی با  MSP 2007تنظیم تقویم در . شود اي مطابق شکل بالا باز می صفحه

Change Working Time  دوTAB کنیم که یکی  مشاهده میexceptions  و دیگريwork weeks است .  

  .کنیم یین میجزئیات آن را تع Detailsکنیم و سپس در قسمت  ابتدا نام استثنا را مشخص می exceptionsدر قسمت 
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توان  میبه طور مثال . هاي مختلفی را انتخاب کرد توان حالت می Detailsکنید در پنجره  همان طور که مشاهده می

توان مشخص کرد که این رویداد در چه زمانی و چند  می Recurrence Patternهاي کاري را تغییر داد یا در قسمت  ساعت

  . شود افتد تعیین می بازده زمانی که رویداد در آن اتفاق می Range of recurrenceبار رخ دهد و در قسمت 

ن توا می Detailsدر قسمت . قرار دارد Defaultکنید تقویم در حالت  همان طور که مشاهده می work weeksدر قسمت 

  . جزئیات آن را تغییر داد

  

  :هاي دیگر داریم تنظیم کرد و در حالت defaultتوان روزهاي هفته را بر اساس  بینید می همان طور که در شکل بالا می

  :کنیم روزهاي تعطیل را در پروژه مشخص می

Set days to nonworking time

  :هیمرا تغییر دهاي کاري پروژه  توانیم ساعت در این حالت می

Set day(s) to these specific working times

را انتخاب کرده و همان  Optionsگزینه  Change working timeبعد از اینکه تنظیمات مربوطه را انجام دادیم از پنجره 

   .کنیم توضیح داده شد، اطلاعات آن را بر اساس تقویم مشخص شده براي پروژه تنظیم می 2003طور که در تقویم 

   :ریزي و زمانبندي پروژهبرنامه

توانیم داشته باشیم باید پروژه را به فازهاي اصلی و فازهاي اصلی را به که براورد خوبی از کل پروژه نمیبا توجه به این

جهت  .شودگفته می ١WBSبه این ساختار شکست، . قدر بشکنیم تا بتوانیم به فعالیت دست یابیمآن... زیرفازهاي اصلی و 

بدون توجه به فاز و (صورت ستونی بنویسیم ها را بهبر روي آن باید ابتدا تمام فعالیت WBSدهی پروژه و اعمال زمانسا

  ).زیرفازهاي آن

                                                            
١ Work Breakdown Structure
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- اکنون فعالیت. ها را زیر آن نوشتها در زیر یک فاز از پروژه قرار بگیرند باید نام فاز را بالاتر و نام فعالیتکه فعالیتبراي این

 Outdentي در سمت چپ آن دکمه. کنیمکلیک می Indentي کنیم و بر روي دکمهفاز را به ماوس انتخاب میهاي هر 

  .دهدوجود دارد که عکس این عمل را انجام می

فاز اصلی را  3سپس خود این . نشان دهد )+(ي کلی فاز را با علامت کنیم تا نتیجهبر روي علامت منفی هر فاز کلیک می

  .ایمپس در واقع از جزء به کل رسیده. دهیمکنیم و زیر فاز اصلی قرار میانتخاب می

 Durationو زمان براوردي هر فعالیت را جلوي آن در ستون ) کلیک کنیم+ روي علامت (اکنون باید تمام فازها را باز کنیم 

 < Tools > Optionsجام فعالیت را در توان مدت زمان ان می. دهیمهاي پروژه بر حسب روز زمان میبه فعالیت. وارد کنیم

Duration is entered in  تبدیل کرد... از روز به ماه، ساعت و.  

  .ها را مشخص کنیمنیازي فعالیتنیازي و یا پساکنون باید روابط پیش

  2FF, 3SF, 4SS, 5FS: رابطه وجود دارد 4پروژه هاي بین فعالیت

- فعالیت پیش IDنیاز هر فعالیت با استفاده از پیش،  Predecessorsها کافی است در ستون بین فعالیتبراي ایجاد رابطه 

قسمت  شود که درباز می Task informationبر روي هر فعالیت منوي  Double Clickو همین طور با .نیازي، نوشته شود

Predecessors نیازهاي آن فعالیت را با وارد کردن توان پیشمیID  نیاز و همین طور نوع رابطه و فعالیت پیشیا نامLag 

  .ها مشخص کردزمانی آن

  :Gantt Chart دهیسازمان

کار بر براي این. را مدنظر قرار دهیم 6توانیم مسیر بحرانیهاي مدیریتی میي تحلیلو ارائه Gantt Chart دهیجهت سازمان

همین طور . کنیمخاب میرا انت Gantt Chart Wizardي گزینهکنیم و کلیک می Gantt Chartي خالی در روي یک نقطه

  .کرد را طی Format > Gantt Chart Wizardمسیر  توانمی

  :زنیمرا می Nextو  را انتخاب کرده Critical Pathو  رسیمزیر می شکل به Nextي با انتخاب گزینه

 Custom taskبا انتخاب  همین طور .تاریخ نوشته شود یا نهتوان انتخاب کرد که در کنار فعالیت منابع و در اینجا می

information ي سپس با انتخاب گزینه. آوردتوان علاوه بر منابع و تاریخ اطلاعات دیگري را اطراف فعالیت میNext  مسیر

  .شودبحرانی مشخص می

                                                            
٢ Finish to Finish  
٣ Start to Finish  
٤ Start to Start  
٥ Finish to Start  
٦ Critical Path  
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توان با ها را هم میي فعالیتشناوري جمعی بقیه .هایی که در مسیر بحرانی قرار دارند برابر صفر استشناوري جمعی فعالیت 

  .مشاهده کرد Total Slackوارد کردن ستون 

را انتخاب کرده و در قسمت  Insert Columnکرده و  Right Clickدر قسمت بالایی یک ستون براي وارد کردن هر ستون 

Field name کنیمستون مورد نظر را انتخاب می.  

  

  :استفاده از تعریف اطلاعات پروژهساختارسازي پروژه با 

Projectبراي این کار از مسیر . تر تعریف کنیماگر بخواهیم پروژه را به جزییات ساختارسازي کنیم، باید اطلاعات آن را دقیق

> Task Information کنیم که داراي استفاده میTabهاي General ،Predecessors، Resources ،Advanced ،

نویسی، فرمولی نوشته باشیم آن را ي فرمولکه اگر در زمینه Custom Fieldو ) Notes( مربوط به فعالیتهاي یادداشت

  .باشددهد، مینشان می

  .کندرا ارائه می... معمولاً اطلاعات عمومی فعالیت شامل زمان کاري، درصد تکمیل و : Generalزیرمنوي 
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  .شدقبلاً به آن اشاره : Predecessorsزیرمنوي 

  

  .گیرددر این قسمت منابع مصرفی براي فعالیت مورد نظر و تعداد آن مورد بررسی قرار می: Resourcesزیرمنوي 
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هاي مشخص مدنظر در تاریخ) Constraints(ها در این منو موارد پیشرفته را از جمله اعمال محدودیت: Advancedزیرمنوي 

-می Constraint typeدر قسمت  در این قسمت اگر بخواهیم محدودیت بر روي فعالیت مورد نظر قرار دهیم .دهیمقرار می

  :مانند را اعمال کنیم هاییتوانیم محدودیت

1.As Soon As Possible)ASAP( :زودترین زمانی که ممکن است یک فعالیت شروع شود.

2.As Late As Possible )ALAP( : ممکن است یک فعالیت شروع شوددیرترین زمانی که). استفاده از حداکثر

)شناوري

3.Finish No Earlier Than :فعالیت زودتر از یک تاریخ خاص تمام نشود.

4.Finish No later Than :فعالیت دیرتر از یک تاریخ خاص تمام نشود.

5.Start No Earlier Than :فعالیت زودتر از یک تاریخ خاص شروع نشود.

6.Start No later Than :فعالیت دیرتر از یک تاریخ خاص شروع نشود.

7.Must Start On :فعالیت باید در یک تاریخ خاص شروع شود.

8.Must Finish On :فعالیت باید در یک تاریخ خاص تمام شود.   

  .زمان مورد نظر را از روي تقویم مشخص کنیم Constraint dateتوان در قسمت طور میو همین 

که زمان فعالیت اینیا ). Fixed Duration(دهد که زمان فعالیت را ثابت نگه داریم این اجازه را به ما می Task type يگزینه

  ...و  )Fixed Unit(را وابسته به تعداد منابع مصرفی کنیم 

را انتخاب  Fixed Unitاگر .کندکنیم طول زمان فعالیت تغییر نمیچه منابع را کم یا زیاد چنان Fixed Durationبا انتخاب 

  .کندکنیم با افزایش یا کاهش تعداد منابع طول زمان فعالیت تغییر می

دهد که اگر یک منبع از یک فعالیت را حذف کنیم تخصیص منبع دیگر به این امکان را به ما می Effort drivenفعال کردن 

دیگري گذاشته شده است و با غیر فعال کردن این گزینه، حذف ي منبع شکل دو برابر خواهد شد یعنی کار دیگران به عهده

  .یک منبع تعهدي براي منابع دیگر ایجاد نمی کن

تاریخی را مشخص کنیم به این مفهوم که فعالیت باید تا  Constraint typeتوان در قسمت می Deadlineبراي تعیین کردن 

.آن تاریخ تمام شود
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  :هابندي کردن فعالیتمرتب کردن، فیلتر و گروه

  .هاستبندي کردن آني زمانبندي مرتب کردن پروژه و گروهبحث در برنامهآخرین 

Sort: ها در ترتیب نمایش فعالیتGantt Chart مسیر  که براي این کار. گیردبا استفاده از مرتب کردن صورت میProject > 

Sort باشد اما عموماً بر اساس ... تواند بر اساس الویت، هزینه، زمان شروع و هر چند مرتب کردن پروژه می. کنیممی را طی

  .شودزمان شروع مرتب می

Filter :که از مسیر  رودکار میبههاي خاص فیلتر کردن براي نشان دادن فعالیتProject > Filter  مثلاً  .کنیممیاستفاده

  .دارند را نمایش دادهایی که در مسیر بحرانی قرار توان فقط فعالیتمی

-هاي فیلتر شده گزارش میفقط از فعالیت MSPدربیاوریم وگرنه  All tasksباید آن را به حالت  Filterپس از استفاده از 

  .گیرد

Group :رود که از مسیر کار میها بهبندي کردن فعالیتبراي گروهProject > Group  توان مثلاً می. کنیماستفاده می

  .هاي غیر بحرانی ببینیمیی که در مسیر بحرانی قرار دارند را به صورت جدا از فعالیتهافعالیت

  :مدیریت منابع

ها در نیروي انسانی، ماشین آلات و سایر تجهیزاتی که فقط وقت آن. شودتقسیم می Materialو  Workي منابع به دو دسته

شوند و در مقابل مواد و مصالح محسوب می Workشود از نوع ها تغییري حاصل نمیپروژه مصرف شده ولی در موجودیت آن

  .شوندخوانده می Material  شود از نوع ها کاسته میها از مقدار موجودیت آنکه مصرف آن

  :تخصیص و تسطیح منابع

  .هاي پروژه استمعناي واگذاري منابع به فعالیتتخصیص منابع به 

  :هاي زیر استکه داراي ستونلیست کرده  View > Resource Sheetبراي این کار تمام منابع پروژه را در  

Resource Name :رودکار مینام منابعی که در کل پروژه به.  

Type : نوع منابع که یا از نوعWork یا از نوعMaterial باشدمی.  

Material Label : از نوع فقط براي منابع (مواد واحدMaterial(  

Initials : حروف اختصاري نام منابع کهDefault باشدها میآن حرف اول آن.  

Group :توان منابع را به صورت گروهی تعریف کردمی.  

Max Unit :مقدار منبع موجود در هر واحد زمان است نه مقدار مورد نیاز!  

Std. Rate :نرخ استاندارد دستمزد در هر واحد زمان است.  

www.sanaye.mee.ir

user
2



١٣

Ovt. Rate :شودکاري منبع در هر واحد زمان است که بعد از پایان ساعات کاري محاسبه مینرخ اضافه.  

Cost/Use :ي آن را بدون توجه به ساعات کاري پرداخت کردبراي منابعی است که نرخ براي هر بار استفاده باید هزینه.  

Accrue At : ي پروژه در اول آن فعالیتهزینهپرداخت یعنی)Start( یا در پایان آن)Finish( زمان اجراي  یا در طول مدت

   .صورت گیرد) Prorated(آن

Base Calendar :شودانتخاب میي هزینه تقویم مورد نظر براي محاسبه.  

Code :توان منابع را کدگذاري کردمی.  

  :روش تخصیص منابع

< Project  توان با انتخاب هر فعالیت در براي تخصیص منابع می Task information/Resources نام منابع و مقدار

به  Tools > Assign Resourcesروي هر فعالیت کلیک کرده و منابع را در توان چنین میهم. ها را وارد کردمورد نیاز آن

  .دهیمها تخصیص میفعالیت

  

  :اضافه تخصیص

با اضافه تخصیص روبرو شویم که این منابع بعضی از منابع  در ها تخصیص دادیم ممکن استکه منابع را به فعالیتبعد از این

  .اندبا رنگ قرمز مشخص شده Resource Sheetدر نماي 

  :هاي زیر وجود داردبراي برطرف کردن این مشکل راه
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آن را  Lagي فعالیت کلیک کرده و کنیم، روي رابطهفعالیتی که شناوري دارد را انتخاب می: استفاده از شناوري.1

.شودکنیم که ببینیم چه زمانی تسطیح میروي نمودار چک می. کنیممی عوض

.استفاده از طولانی کردن زمان فعالیت.2

کنیم عوض میرا Assign Resources ،  Unitفعالیت بحرانی را انتخاب کرده و در قسمت : سازي فعالیتفشرده.3

.شودانجام میشود و تسطیح کم می Work ،Durationدر این حالت با ثابت بودن 

 Resource Workدر آن  Right Clickکرده و با  Splitصفحه را  Window > Splitاز : کارياستفاده از اضافه.4

:دانیممی.شودکم می Durationرا زیاد کنیم  Ovt. Workاگر . کنیمرا انتخاب می

Ovt. Work + Work = Unit × Duration

.گیردانجام می Edit > Split Taskاین کار در : هاشکستن فعالیت.5

استفاده از تسطیح کامپیوتري.6

  : تسطیح منابع

هاي زمانی با منابع ها بالاست، منابع کاهش داده شود و در دورههاي زمانی که سطح منابع مورد نیاز در آنبهتر است در دوره

هاي زمانی متوالی به ود سطح منابع مورد نیاز در دورهشبه عبارت دیگر تلاش می. مورد نیاز کم، میزان منابع افزایش داده شود

  .شودبه این عمل تسطیح گفته می. یکدیگر نزدیک شود

هاي زمانی مختلف کاهش یا افزایش سطح منابع در دوره. هاي زمانی متوالی یکسان نگرددممکن است سطح منابع در دوره

  .پذیردها صورت میي زمانی شناوري آنلهدر فاصها اجراي پروژه، با تغییر زمان بعضی از فعالیت

  .کنیممی طی Tools > Level Resourcesمسیر  براي تسطیح منابع

هاي جدید پروژه به صورت را انتخاب کنیم تمام فعالیت Automaticرا انتخاب کنیم چون اگر  Manualبهتر است 

در  .شودهاي جدید نمیتسطیح منابع شامل فعالیت کنیمرا انتخاب می Manualشود ولی وقتی حالت اتوماتیک تسطیح می

 Leveling  توان روز به روز یا هفته به هفته و در قسمت عمل تسطیح را می Look for overallocations onقسمت 

rang  سپس با انتخاب  .توان نوع تسطیح را نیز تعیین کردهمین طور می .تنظیم کرددر تاریخ خاصی یا براي کل پروژه

  .شودتسطیح انجام می Level Nowي زینهگ
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  ):Save Baseline(ي مبنا تنظیم برنامه

 < Toolsمسیر  براي این کار. آماده است Baselineي زمانبندي یا بعد از انجام تخصیص و تسطیح منابع اکنون برنامه

Tracking > Save Baseline سپس با انتخاب . کنیممی طیBaseline ي براي کل پروژه گزینهOk کنیمرا انتخاب می.  
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  :بهنگام سازي پروژه

این به روز رسانی . خواهیم ارائه دهیم ها تا آن لحظه را می تاریخی است که گزارشات مربوط به کنترل فعالیت updateتاریخ 

  :کنیم از مسیر زیر استفاده می MSPجهت بروز رسانی پروژه در . تواند براي یک تک فعالیت و هم براي کل پروژه باشد می

Tools < Tracking < Update Tasks

  

Tools < Tracking < Update Project

  

:نویسیفرمول

خل آنها حاصل از یک فرمول تعریف شده توان تعریف کرد که اطلاعات دا هاي دلخواهی می، فیلدMicrosoft Projectدر 

فرمولی که به . را انتخاب کنید formulaي  گزینه Tools > customize > fieldsي  براي تعریف فرمول در پنجره. باشد

  . شود ها اعمال می شود تنها به منابع و فعالیت این ترتیب وارد می
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ها و مقدارهاي  اعداد، متن(توانند به طور دستی وارد شوند  یکی مقادیري هستند که می. هر فرمول دو نوع داده اصلی دارد

ها، عملگرها و توابع هستند که چگونگی ترکیب مقادیر را  گروه دوم داده. و دیگري از مقادیر فیلدها استخراج شوند) پولی

  .کنند مشخص می

عملگرها براي . هایی که براي درج آنها وجود دارد، استفاده کرد توان تایپ کرد یا از دکمه هاي گفته شده را می تمام داده

  . قابل دسترسی هستند Fieldو فیلدها نیز تز طریق  Functions، توابع در ي کادر وجود دارد هایی در میانه دکمه
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  :تنظیمات مهم پروژه

  :است هاي مهم آن اشاره شده Tabدر زیر به . توان تنظیمات لازم را روي پروژه انجام دادمی Tools > Optionsمنوي در 

Schedule :در قسمت . کندي زمانبندي را ارایه میاین گزینه تنظیمات مهم برنامهShow assignment units as a 

توان در همین طور می. نشان داد) Decimal(یا اعشاري ) Percentage(توان منابع تخصیصی را به صورت درصدي می

و نوع کل . انجام گیرد یا در تاریخ کنونیشروع پروژه  تاریخ شروع فعالیت جدید در تنظیم کرد که New tasksقسمت 

بودن  Effort Driven. ...)و  Fixed Duration, Fixed Units(توان در این زیرمنو تعیین کرد ها را هم میفعالیت

.جا قابل تنظیم استها هم در اینفعالیت
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View:  در قسمتDate format هم در قسمت واحد پول را . ي نمایش تاریخ را تعیین کردتوان نحوهمیCurrency 

options توان مشخص کردمی.  

  

General: ترین قسمت آن تعیین مهم. گیردریزي انجام میي موارد عمومی برنامهدر این بخش تنظیمات کلی در زمینه

  ...$/hریال یا /hباشد مثلاً می Ovt. Rateو  Std. Rateواحدهاي 
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Edit: را انجام داد... توان تنظیماتی مانند علائم اختصاري براي دقیقه و ساعت و در این قسمت هم می.  

  

  :افزارچند نماي مهم نرم

Gantt Chart :شوددر این قسمت علاوه بر نمودار گانت، نماي اصلی کار نیز نشان داده می.  

Network Diagram :اي نام دارندهاي گرهکه شبکه شودترسیم میجا اي پروژه در ایندیاگرام شبکه.  

Task Usage: ي هر فعالیت را دنبال کردتوان مقادیر کار و هزینهدر این قسمت می.  

Resource Graph: ي هر کدام در هر روز از هفته مشخص ریزي شدهدر این قسمت نام تمام منابع و مقدار مصرف برنامه

  .دارند) Overallocate(ي منابعی است که اضافه تخصیصیري سادهاز مزایاي این نما، پیگ. شده است

Sheet Resource: هاي کاري منابع بر اساس کاري و زماني استاندارد و اضافههاي مربوط به منابع، هزینهدر این نما داده

  .شودتقویم مشخص می

Resource Usage: دهد که این نما همان کاري را انجام میTask Usage دهد با این تفاوت که در این قسمت انجام می

  .ها در طی زمان استجاي فعالیت، منابع و مصرف آنبهبندي معیار طبقه
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  :بنديفرمت

Font : درFormat > Font توان میFont را به صورت تکی تغییر داد هاها و اندازه و رنگ آننوشته.  

  

Text Styles :Format > Text Styles مانندFont  است با این تفاوت که در قسمتItem to Change توان می

  .شود نه تکیاین تغییرات به صورت کلی اعمال می .ها تغییر کندکدام فعالیت Fontمشخص کرد که 
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Bar : درFormat > Bar توان خصوصیات ظاهري یک میBar که در سمت راست و چپ و وسط آن چه چیزهایی و این

  .تعیین کردنوشته شود را 

  

Bar Styles : درFormat > Bar Styles توان در شکل میBar توان در ضمن می. ها به صورت کلی تغییراتی را ایجاد کرد

Baseline  و پروژه را هم نمایش دادGantt Chart یک ردیف از . هر فعالیت را دو ردیفه کردBaseline Start  تا

Baseline Finish  و یک ردیف ازActual Start  تاActual Finish را نشان دهد.  
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  :ي آنهاو تهیه هاگزارش

 < Viewدر را این کار  .هاي مرتبط با پروژه استي انواع گزارشریزي و کنترل پروژه تهیهیکی از وظایف مهم واحد برنامه

Reports توان انجام دادمی.  

  

  :هاانواع گزارش

Overview :که شامل گزارش از نتایج کلی پروژه، کارهاي سطح  زیر منوي آن. دهدارایه میهاي مروري و کلی را گزارش

  :به شکل زیر است باشد،می... ها در مسیر بحرانی وبالاي پروژه، فعالیت

  

  

Current Activities: هاي شروع نشده، گیري از فعالیتبینیم این بخش شامل گزارشهمان طور که در شکل زیر می

  .باشدمی... شوند و که به زودي شروع میهایی فعالیت
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Costs: توان گزارش گرفتمی... ي پروژه و در این بخش نیز از جریان نقدینگی، بودجه.  

  

Assignments: شویم که چه کسی، چه کاري را در چه زمانی باید انجام دهدهاي این قسمت متوجه میبا گزارش.  
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Workload: ها را بشناسیمتوانیم منابع مصرفی و فعالیتمیهاي این بخش از گزارش.  

  

Custom: هاي خاص را سفارش دهیمتوان گزارشبا استفاده از این قسمت می.  
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محاسبه زمان در MSP

فعالیت ها از نظر محاسبه زمان در MSP به سه دسته تقسیم می شوند:


1)Fix Duration  (دوره زمانی مشخص شده)


2)Fix Work  (کار مشخص شده)


3)Fix Unite  (واحد مشخص شده)


با مشخص کردن یک فعالیت به عنوان یک فعالیت وابسته به زمان یا همان Fix Duration در صورت درج زمان برای این فعالیت این زمان ثابت خواهد بود و با تغییر در منابع، زمان فعالیت تغییر نخواهد کرد.در حالی که فعالیت اگر وابسته به منبع یا همان   Fix Work یا Fix Unite  باشد در صورت تغییر منبع زمان فعالیت هم تغییر پیدا می کند. با توجه به ثابت بودن زمان پروژه ها یا به عبارتی Fix Duration پروژه به شما پیشنهاد می شود که پروژه را به صورت Fix Duration انجام بدهید .در پروژه های عمرانی و به خصوص پروژه هایی که در ایران انجام می شود معمولا زمان پروژه و زمان فازهای اجرایی عدد ثابتی است و مدیران با توجه به چنین زمان هایی به دنبال تامین منابع مورد نیاز خود می روند. حال برای تعریف قید زمانی برای فعالیت ها چگونه باید عمل کرد:


روی فعالیت مورد نظر دو بار سریع کلیک می کنیم و صفحه ای مثل صفحه زیر ظاهر می شود.
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ما روی گزینه Advanced کلیک می کنیم. و بعد روی گزینه ی  Constraint  Type نوع قید هایی را که در MSP پیشرفته قسمت اول گفتیم را انتخاب می کنید.
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و بعد گزینه OK را می زنیم.


یک نکته قابل توجه این است که بدانیم تمامی فعالیت ها درMSP  به صورتAs Soon As possible  به صورت پیش فرض هستند.در این صورت تاریخ شروع و پایان آن ها بر اساس زمان و روابط آن ها محاسبه می شود برای اینکه فعالیت های پروژه را بتوان به صورت  Fix Duration  تعریف کرد و از وابستگی به منابع رها کرد به صورت زیر عمل می کنیم.


روی فعالیت مورد نظر دوبار کلیک می کنیم و وقتی پنجره Task Information  باز شد دوباره وارد گزینه ی Advanced می شویم و بعد در قسمت Task Type گزینه Fix Duration  را انتخاب می کنیم .
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و بعد از آن گزینه   Effort Driven [image: image5.png][V]Effort driven




    را که در کنار همان گزینه است را غیر فعال می کنیم و بعد از OK را می زنیم.


حال فعالیت شما  Fix Duration است و از حالت Fix Work و یا  Fix Unite خارج است.


برای اینکه تمام فعالیت های ما به حالت Fix Duration  قرار گیرد می توانید تمام آن ها را با Drag & Drop  کردن انتخاب کنید و از منوی Project گزینه Task Information را بزنید و تمام آنها را در حالت Fix Duration  قرار دهید.


فعالیت های دوره ای      


فعالیت هایی که در طول یک دوره و یا در قسمتی از زمان پروژه به طور مرتب و در فواصل زمانی یکسان اتفاق می افتند ،مثل تشکیل جلسه هفتگی در روزهای خاصی از هفته .


برای این کار یک سطر خالی از نمای Gantt Chart را انتخاب می کنیم بعد، از منوی Insert گزینه Recurring Task را انتخاب می کنیم.
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در قسمت نام یا همان Task Name نام فعالیتی که می خواهیم انجام دهیم را وارد می کنیم به عنوان مثال تشکیل جلسات هفتگی و بعد در قسمتDuration مدت زمان فعالیت را انتخاب می کنیم و بعد در قسمت بعدی روزهایی که می خواهیم را انتخاب می کنیم. و تاریخ شروع و پایان را هم مشخص می کنیم.
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که وقتی ok را بزنید سوالی از شما پرسیده می شود مبنی بر این که جلسات 53 روز می شود آیا تمایل دارید و شما گزینه YES را انتخاب می کنید.
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حال می بینید تمام جلسات هفتگی به جدول Gantt Chart اضافه شده است.
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ایجاد یک یادداشت برای یک فعالیت

یکی از مزایای MSP تعریف یک یادداشت برای یک فعالیت است که وقتی شما روی آن قرار بگیرید آن یادداشت ظاهر می شود.


برای این کار روی فعالیت مورد نظر دو بار کلیک می کنید و بعد از آن روی گزینهNotes  کلیک کرده و یادداشت مورد نظر خود را تایپ می کنیم به عنوان مثال ما برای قسمت نقشه برداری تایپ می کنیم: باید از نقشه برداران حرفه ای استفاده شود و بعد ok را می زنیم.
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مشاهده می کنید که در کنار فعالیت یک آیکون جدید به وجود آمد که اگر ما روی این آیکون قرار بگیریم نکته مهمی که در رابطه با این Task وجود داشت ظاهر می شود.
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نحوه ارتباطات یا Relationship بین فعالیت ها

به طور کلی درMSP  چهار نوع ارتباط می توان بین فعالیت های پروژه برقرار کرد. که این ارتباط ها به این صورت است:


1) ارتباط FS(Finish to Start)  


این ارتباط به این گونه است که شروع فعالیت به پایان فعالیت دیگر وابسته است.


2) ارتباط SS(start to start) 


شروع فعالیت به شروع فعالیت پیش نیاز وابسته است.


3) ارتباط  FF(Finish to Finish)

پایان فعالیت به پایان فعالیت پیش نیاز وابسته است.


4) ارتباطSF(Start to Finish)


شروع فعالیت پیش نیاز پایان فعالیت بعدی است. به عنوان مثال نگهبان شیفت(2) شروع فعالیتش به پایان فعالیت نگهبان شیفت (1) وابسته است.


در MSP می توان به طرق مختلف ارتباط بین فعالیت ها را برقرار کرد:


روش اول:


اگر نوع ارتباط شما بین فعالیت ها از نوع FS بود می توانید به عنوان سریع ترین راه این کار را انجام دهید :


فعالیت مورد نظر را انتخاب کنید:
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از منوی Edit گزینه Link Task  را انتخاب می کنیم.
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در صورتی که بخواهیم ارتباط ایجاد شده را از بین ببریم دوباره فعالیت انتخاب کرده از منوی Edit گزینه Out Link را انتخاب می کنیم.


روش دوم: 


روی فعالیتی که می خواهیم انتخاب کنیم دوبار کلیک می کنیم و بعد روی گزینه Predecessors رفته و شماره پیش نیاز یا همان ID فعالیت را تایپ می کنیم.


به عنوان مثال پیش نیاز خاک برداری نقشه برداری است که در صورت نیاز می توانید در قسمت Lag  میزان تاخیر فعالیت را وارد نمایید.
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و در قسمت Type  شما میتوانید نوع ارتباط که SF،SS،FF و FS را مشخص کنید.


روش سوم:


از منوی Window گزینه ی split را انتخاب می کنیم .
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همانگونه که مشاهده می کنید پنجره ای برای شما باز می شود. در صفحه پایینی کلیک راست می کنیم که پنجره ای باز می شود مانند شکل زیر :
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روی گزینه Predecessors & successors کلیک می کنیم.و سپس فعالیتی را که می خواهیم برای آن وابستگی تعریف کنیم در نمای Gantt Chart  انتخاب می کنیم . و در قسمت پایین در قسمت Type نوع ارتباط را تعریف می کنیم.
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و در قسمتID شماره پیش نیاز که در قسمت قبل هم توضیح دادیم را وارد می کنیم.


بعد از این که این کار را انجام دادیم دکمه OK را می زنیم.
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و برای از بین بردن پنجره ایجاد شده وارد window شده و گزینه ی Hide را می زنیم.


تخمین زمان فعالیت ها

یکی از مراحل مهم در برنامه ریزی و کنترل پروژه به کمک نرم افزار MSP تعریف زمان فعالیت ها است .زمان فعالیت ها را می توان به راحتی در منوی Gantt Chart در ستون Duration وارد کنیم اما نکته مهم رسیدن به یک تخمین مناسب از زمان فعالیت ها است. تخمین زمان فعالیت های پروژه با توجه به نوع پروژه و نوع نگرشی که به مدیریت اجرایی پروژه خواهیم داشت متفاوت است.


ممکن است شما برای دو فعالیت یکسان در دو پروژه متفاوت زمان های متفاوتی را وارد کنید چون شرایط اجرایی در دو پروژه متفاوت است.


برای این که بتوان مدت زمان فعالیت را تخمین زد از روش های زیر استفاده می کنیم:


1. اطلاعات قدیمی قبلی ، مانند پروژه هایی که قبلا انجام شده.

2. از طریق افرادی که قرار است فعالیت را انجام دهند.

3. نظر کارشناسانی که قبلا پروژه ای شبیه پروژه شما را مدیریت کرده اند.

4. سازمان صنعتی یا حرفه ای که پروژه های شبیه پروژه شما در ارتباط هستند.

در پروژه های پیچیده برای تخمین مدت زمان فعالیت ، ممکن است از ترکیب روش های فوق و یا روش دیگر استفاده کنید. زیرا تخمین هایی که دقیق نیستند ، ریسک انجام پروژه را بالا می برند. شما برای وارد نمودن زمان پیش بینی شده می توانید به صورت زیر عمل کنید:


اول از منوی Project وارد گزینه Project Information می شوید:

[image: image19.png]Sort.

Eitered for: Al Tasks

Group by: No Group

Qutiine

WBS

Task Information... ~ Shift+F2
Task Notes...

Task Drivers

CE R

Project Information. ..







بعد پنجره زیر باز می شود:
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شما میتوانید در قسمت Start date روز شروع فعالیت و در قسمت Finish date تاریخ پایان فعالیت را وارد نمایید و در قسمت های بعدی بر نامه ای که می خواهید برای زمان بندی پروژه خود داشته باشید را انجام دهید.و وقتی Ok را بزنید در قسمت Start و Duration جدول Gant Chart به صورت زیر زمان ها وارد می شوند:
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و در قسمت راست جدول Gantt Chart یعنی جدول نمودارها ، نمودارها به صورت زیر در می آ ید.
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علامت سوالی که در کنار روزهای موجود در قسمت Duration  می بینید نشانه تخمینی بودن زمان مورد نظر است.


اگر این علامت سوال برای شما مشخص نبود می توانید از منوی  Project وارد گزینه Filter  شوید و آن را فعال کنید.
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اضافه و یا کم کردن ستون در Gantt Chart

ما می توانیم یک ستون در فضای Gantt Chart اضافه یا کم کنیم.برای این کار روی آن ستون کلیک راست انجام داده و گزینه Hide Column را انتخاب می کنیم.
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و برای اضافه کردن ستون روی یکی از ستون ها کلیک راست کرده و گزینه[image: image3.png]



 را انتخاب می کنیم که پنجره ای مانند پنجره زیر برای شما باز می شود.
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در قسمت Title تیتری که مورد نظرمان است  را وارد می کنیم و در آخر OK را می زنیم.

 CPM (روش مسیر بحرانی)


هدف ما از تعریف WBS یک پروژه و ایجاد ارتباطات و زمان فعالیت رسیدن به یک شبکه زمان بندی است.

شبکه زمان بندی پروژه شامل فعالیت ها، ارتباطات و زمان فعالیت ها است که در برنامه ریزی زمان پروژه به ما کمک می کند. شبکه زمان بندی به ما می گوید چه فعالیت هایی با چه تقدم و تأخری باید نسبت به هم باشند و قبل از شروع فعالیت چه فعالیت هایی باید انجام شوند. در شبکه زمان بندی، زمان فعالیت ها مشخص شده است و زمان انجام کل پروژه را می توان به کمک شبکه زمان بندی پیش بینی کرد.


مسیری که طولانی ترین زمان را تعیین می کند و به اصطلاح مسیر بحرانی پروژه است در شبکه زمان بندی مشخص می شود.


مشخصات مسیر بحرانی 


مسیر بحرانی مانند هر مسیر دیگری در پروژه  از اولین فعالیت شبکه شروع می​شود و تا آخرین فعالیت بدون هیچ گسستی ادامه پیدا می کند مسیر بحرانی طولانی ترین مسیر و بزرگترین مسیر شبکه زمان بندی ها است.


فعالیت هایی که در مسیر بحرانی قرار دارد همگی بحرانی هستند و به عبارتی شناوری آن ها صفر است. هر پروژه حداقل یک مسیر بحرانی دارد ممکن است در طول پروژه به علت عقب افتادن و اضافه شدن زمان فعالیت ها مسیر بحرانی تغییر پیدا کند، پس با اضافه شدن زمان مسیر بحرانی زمان پروژه هم زیاد می​شود و در صورت کاهش زمان فعالیت های مسیر بحرانی زمان پروژه هم کاهش پیدا می کند.


جهت انجام به موقع پروژه بهتر است تمرکز ما بیشتر روی فعالیت های مسیر بحرانی باشد البته نباید از سایر فعالیت ها هم غافل بشویم چون تأخیر زیاد در سایر فعالیت ها هم ممکن است آن ها را بحرانی کند.


مشخص کردن زمان بحرانی به کمک MSP


می توانیم پیگیری مسیر زمان بندی پروژه در MSP را به دو صورت Gantt Chart و Network Diagram  مشاهده کنیم که در منوی View شما هر دوی آن ها  را دارید.

مسیر زمان بحرانی در Gantt Chart

در Gantt Chart زمان فعالیت ها به صورت میله های مستطیلی شکل هستند.
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و ارتباط بین آن ها به صورت بردار مشخص می شود. برای مشخص کردن مسیر بحرانی در نمای Gantt Chart کار های زیر را انجام می دهیم.


از منوی Format گزینه [image: image6.png]‘ <y Gantt Chart Wizard...




 را انتخاب می کنیم. بعد از این که صفحه یGantt Chart Wizard  ظاهر شد گزینه Standard را Next کرده و در قسمت بعدی Custom Gantt Chart  را Next  می کنیم.
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سپس مشخص می کنیم در  چه قسمتی این اطلاعات را برای ما وارد کند که در آخر به صورت زیر مشخص می شود.
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 مسیر بحرانی درNetwork Diagram

ابتدا Network Diagram را انتخاب می کنیم.  


[image: image9.png]‘. Network Diagram ‘






 در نمای Network Diagram هر فعالیت با یک " گره مستطیلی شکل "، نشان داده شده است.
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و ارتباطات بین فعالیت ها با بردار خطی مشخص شده است به عبارت دیگر این نماد همان شبکه گره ای زمان بندی است.


در گره های مستطیل شکل مربوط به فعالیت ها اطلاعات فعالیت از قبیل : تاریخ شروع، تاریخ پایان زمان، درصد پیشروی و غیره دیده می شود و این اطلاعات قابل ویرایش هستند. برای این کار می توانید دو بار روی آن ها کلیک کنید تا به صورت زیر در آیند و بعد آنها را ویرایش کنید.


[image: image11.png]





اگر می خواهید بر روی ارتباط بین فعالیت ها بیشتر تمرکز کنید این نما  می​تواند از نمای Gantt Chart  برای شما مفید تر باشد.


مسیر بحرانی در نمای Network Diagram  با رنگ قرمز مشخص می​شود.


چگونه Network Diagram  را به دلخواه خود تغییر دهیم

ابتدا وارد منوی Format می شوید و گزینه Box Style را کلیک کرده [image: image12.png]





در آنجا می توانید Network Diagram خود را تغییر دهید.
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از قسمت Shape :" شکل "،  از بخش Color : " رنگ "،  از بخش Border می توان " شکل، رنگ و ضخامت خط دور شکل "  و از قسمت Back ground می توان " رنگ و قالب پس زمینه شکل " را تغییر داد، که همه این تغییرات در بخش Preview قابل مشاهده هستند. با زدن دکمه Ok این تغییرات اعمال می شوند.


تعریف و تخصیص منابع (assignment resource definition)

یکی از فاز های مهم در مبحث برنامه ریزی و کنترل پروژه فاز تعریف و تخصیص منابع است. در حال حاضر در کشور ما  هنگام استفاده از نرم افزار MSP و سایر نرم افزارهای کنترل پروژه مثل پریماورا به " منابع " زیاد توجه نمی کنند.نکته ی حائز اهمیت زمان فعالیت ها است،  اما معدود شرکت ها و سازمان هایی هستند که به خوبی این امکان نرم افزار را شناخته اند و به منابع توجه بیشتری دارند.


روش تعریف منابع

منابع معمولاً شامل نیروی انسانی مثل کارگر، ماشین آلات، مصالح، تجهیزات و مانند این ها هستند.


در این نرم افزار دو نوع منبع قابل تعریف است، یکی  Work و یا کار و دیگری Material یا مواد است. نیروی انسانی و ماشین آلات به عنوان Work و مصالح به عنوان Material بکار برده می شود.


در MSP می توان تعریف منابع را در حین تخصیص منابع  انجام داد.اما اگر نخواهیم این کار را بکنیم می توانیم به این روش عمل کنیم:


از منوی View گزینه Resource Sheet  را انتخاب می کنیم.
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در ستون Type نوع منبع (Material یا Cost یا Work) را انتخاب می​کنیم.
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در ستونMaterial Label برای منابع Material نام واحد منبع را یادداشت می کنیم،  مثل متر مکعب.
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در ستون Initials حرف اختصاری جهت منبع را وارد می کنیم
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اگر این کار را انجام ندهیم نرم افزار به طور خودکار حرف اول نام منبع را در این ستون قرار می دهد. در ستون Group  نام گروه منبع را وارد می کنیم. این گروه بندی ها به هنگام گزارش پروژه به کار می آیند.


در ستون Max units  حداکثر مقدار در دسترس منبع را وارد کنید.
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بعضی اوقات وقتی ماوس را روی بعضی نقاط می گیریم یک پنجره کوچک به عنوان Help باز می شود که با کلیک بر روی آن لینک موجود در آن پنجره بزرگتر Help باز شده و در مورد موضوع مورد نظر اطلاعاتی به ما می دهد.

[image: image19.png]Initisls Group  Max.Units = Std.Rate =~ Ovt.Rate = Costllse Accrue At Base Calendar Code






در ستون STD. Rate نرخ استاندارد واحد منبع را وارد می کنیم.


در ستون Ovt . Rate نرخ اضافه کاری هر واحد را وارد می کنیم.


در ستون USA/Cost  نرخ هزینه بر واحد منبع را وارد می کنیم


در ستون Accrue At نحوه پرداخت هزینه را انتخاب می کنیم.

Start به معنی پرداخت هزینه در شروع فعالیت، End در پایان فعالیت و prorated در طول فعالیت را نشان می دهد. در ستون  Bas Calendar تقویم منبع را انتخاب می کنیم که Standard  باشد یا بر اساس تقویمی که قبلاً توضیح داده شده کارها را انجام دهد.


تنظیمات مربوط به محاسبات 

از منوی Tools گزینه Options را انتخاب می کنیم.
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در پنجره باز شده تب General را باز می کنیم.
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در این قسمت Default Standard Rate  و Default Overtime rate را ریال یا تومان در ساعت نظر می گیریم.


در تب View در قسمت Decimal digits تعداد رقم اعشار را مشخص می کنیم.در بخشPlacement  نوع نمایش هزینه را می توان مشخص کرد که به چه شکل باشد و با زدن Ok تنظیمات اعمال می شود.


بعد از برآورد منابع مورد نیاز برای فعالیت می توانیم به مدت های مختلف تخصیص منابع را در MSP انجام دهیم. قبل از این که تخصیص منابع را شروع کنیم،  تمام فعالیت ها را از وابستگی به منبع رها کنیم. برای این کار تمام فعالیت ها انتخاب کرده از منوی Project وارد قسمت Task Information شده در تب Advance،  Task Type را به صورت Fined Duration قرار داده و Driver را غیر فعال می کنیم. سپس Ok می کنیم.
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بهترین روش تخصیص منابع در این نرم افزار این است که در منوی View گزینه Gantt Chart را انتخاب کنیم و Gantt Chart را مشاهده کنیم.سپس از منوی Tools گزینه Assign Resources را انتخاب می​کنیم یا Alt+F10 را می زنیم.
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تا پنجره Assign Resources باز شود. فعالیتی که می خواهیم به آن منبع اختصاصی دهیم انتخاب کرده مقدار مورد نیاز منابع مورد نظر را طبق برآورد انتخاب کرده در فیلد Unite وارد می کنیم و کلید Assign را می زنیم و سپس آن را Close می کنیم.
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اگر بخواهیم هنگام تخصیص منابع منبع جدیدی را که در لیست وجود نداشت وارد کنیم،  در همان پنجره در انتهای لیست و در یک سطر خالی اسم منبع جدید را وارد می کنیم در MSP به طور پیش فرض منبع Work در نظر گرفته می شود که برای تغییر آن رو سطر منبع جدید دوبار کلیک می کنیم و در پنجره باز شده از بخش Type  " نوع " آن،از بخش Material Label  "واحد " آن و از بخش Initials " حرف اختصاصی " آن مشخص می شود و با Ok پنجره را می بندیم. 
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در ستونMax Unite برای تغییر دادن درصد به عدد  و بالعکس به این روش عمل می کنیم:

 در منوی Tools، دکمه Options را در حالت Decimal برای تعداد و Percentage برای درصد قرار داده و Ok را می زنیم.


از منوی View، گزینه Gantt Chart را به صورت فعال در آورده، از منوی Windows گزینه Split را فعال می کنیم.در زیر پنجره ای باز می شود که Resource home و تغییر اطلاعات را در معرض دید قرار می دهد. برای بستن با کلیک راست بر روی پنجره گزینه Hide From View را می زنیم.
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تصحیح منابع به منظور رفع تداخل منابع

تداخل منبع زمانی رخ می دهد که به یک منبع بیش از آن که می تواند کار تخصیص شده باشد. تخصیص منابع به صورت اتوماتیک به این صورت انجام می​شود :


اگر از تصحیح اتوماتیک استفاده کنیم، MSP با توجه به وابستگی ها زمان شناوری،  تاریخ ها، اولویت ها، قیود زمانی یا محدودیت های تعریف شده مشخص می کند که کدام فعالیت باید به تأخیر بیفتد. قبل از تصحیح اتوماتیک باید تا جای ممکن زمان بندی پروژه را مورد ارزیابی و تحلیل قرار دهیم و به وسیله تصحیح دستی تداخل منبع را رفع کنیم. هنگامی که زمان بندی پروژه بر اساس تاریخ پایان است نباید از تصحیح اتوماتیک استفاده کنیم چون این کار موجب تغییر تاریخ پایان فعالیت ها و در نتیجه تاریخ پایان پروژه می شود.


برای تصحیح اتوماتیک از منوی Tools گزینه Level Resource را انتخاب می کنیم. در پنجره باز شده در بخش Leveling Calculation گزینه Automatic را انتخاب کرده روی گزینه Level Now کلیک می کنیم.
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گزارش گیری منابع

MSP گزارش های مختلفی برای ما تولید می کند که ما می توانیم از آن ها جهت ارئه اطلاعات به مدیران پروژه یا در جلسات اجرایی پروژه یا در تجزیه و تحلیل پروژه استفاده کنیم.در MSP می توان منابع مورد نیاز پروژه را در دوره های مختلف زمان گزارش گیری کنیم. محاسبات این گزارش ها بر اساس تخصیص هایی است که به فعالیت ها داده ایم مثل مدت زمان تاریخ شروع و پایان فعالیت ها.

گزارش گیری از منابع پروژه

از منوی Report گزینه Reports را انتخاب کرده در پنجره باز شده گزارش های Work load را انتخاب کرده Select  را می زنیم.در پنجره باز شده Resource usage را انتخاب کرده،  Edit را زده،  جزئیات را مشخص کرده و پس از زدن Ok گزینه Select را انتخاب می کنیم   گزارش آماده نشان داده می شود.
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اگر بخواهیم گزارشات مقدار منابع مورد نیاز پروژه خود را به تفکیک در جداول جداگانه بگیریم از منوی View گزینه Resource Sheet را انتخاب کرده،  پس از تعریف گروه برای هر منبع در ستون Group،  به قسمت Report رفته،  Work Load را انتخاب می کنیم. در پنجره باز شده Resource usage را انتخاب می کنیم و Edit را می زنیم و در بخش Filter، Group را مشخص می کنیم و Ok را می زنیم.


با زدن Select،  پنجره ای باز شده که نام گروه مورد نظر را می خواهد،  با زدن آن و Ok کردن، گزارش گروه بر روی صفحه نشان داده می شود.


برای گزارش گیری از هزینه های مورد نیاز پروژه این عمل را انجام می دهیم:


از منوی View گزینه Resource را غیر فعال کرده،  بر اساس جدول مقدار منابع مورد نیاز پروژه هزینه منابع را پیش بینی می کنیم.


برای این کار پس از وارد کردن نرخ واحد منبع در ستون Std. rote وارد پنجره Reports  شده Costs را انتخاب کرده Select را می زنیم. در پنجره باز شده  Cash Slow را انتخاب کرده،  Edit را می زنیم.


و از بخش Filter شکل مورد نظر را انتخاب کرده،  Ok کرده، Select را می​زنیم.گزارش نشان داده می شود.
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پیش بینی هزینه های پروژه

معمولا در گزارش های کنترل پروژه از نمودارها و گراف ها استفاده می شود تا مدیران راحت تر تجزیه و تحلیل کنند. یکی از مهمترین نمودارها در این کار نمودار S7 است. که از اطلاعات و گزارشات MSP می توان جهت رسم این نمودارها استفاده کرد.


برای رسم نمودار S پیش بینی هزینه های پروژه  می توان از نرم افزارExcel استفاده کرده و برای این کار پنجره Reports را باز کرده،  Costs را انتخاب می کنیم.
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در پنجره باز شده Cash slow را انتخاب کرده،  Select را می زنیم .


وقتی گزارش دیده شد عددی را که در سطر از ستون Total قرار دارد را به نرم افزار Excel منتقل می کنیم و نمودارS را می کشیم.
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